Presentations

Module 6




Basics

Open Application
Close Application
Close a presentation

Opening an existing power
point

Opening multiple power
points

Create a new power point
Saving a power point
Saving a power point to

another file type

Switch between open
windows

Username

Change default file location
Help Function

Zoom Tool

Minimize/ Restore Ribbon
Spell Check (Pg 49)



Presentation View Options

 From these views, you can create and edit your
slides. These are accessed from the View tab.

1. Normal View — graphical editing

2. Slide sorter —to sort and to have an overview of
all slides

3. Notes page view — to add notes to a particular
slide

4. Slide show — runs the slide
5. Outline —the best view for editing slides




Good Practice

* Use different title for each slide to distinguish
in the outline view

e Slide Content should be numbered



Enter Slides and Layout

From Home tab

Be careful which layout to
chose

v’ Title
subtitle

v’ Title and Content:
and bulleted list

v' Content and Caption: Title
and text slide with
chart/table/spreadsheet

slide: title and

title

G| Home

[=C1

Insert

Design

J 55| Layout =

Transitions

J ] Calibri (B
[E5) Reset
Paste Mew B 7
> # Format Painter | | 5jige -
Office Theme
Title Slide Title and Content Section Header

Two Content

Comparison

Title Cnly

i
[TETTTTEee

[

Elank

Content with
Caption

=] Duplicate Selected Slides

=] PReuse 5lides...

=] Sslides from Qutline...

Picture with
Caption



Enter Text in slide

* Click to add text e Click to add text

Click in the box labelled click to add text and
start writing. Power point will wrap text
automatically




Apply Design to your Presentation

Wu

[ e

From the Design Tab choose the preferred
Design

These are all built in designs



Change the colour background of slide

- GO tO the SI|d€(S) Ag Aa \i@ BA | ETDIQ_”' 9| Background Styles

" Click on Design Tab

= Background styles ur backgrou!

" Format Background

_______________

" Close —to apply to the
running slide

Picture Corrections @ Solid fill

. Picture Color Gradient fill
—
N Picture or texture fill
sssssssss
Pattern fil
Hide background graphics

presentation —

Method 2: Right click on the slide




e Slide S
View

Change Slide Position
* View Tab

orter

File | Home Insert Design

ormal | Slide
Page View

Master Master

Presentation

Apply Design to your Presentation Pg

* Drag and Drop |~

Transitions

MNotes Reading Slide Handout MNotes
Master

Animations

BasicsPg 1-10

Slide Show Review iew
3 E @ color 1 = amrange an
b = Grayscale T [P cascade
Zoom Fitto » Mew
Window | wm Black and White | window

Presentation View Options Pg10

it your

E ow -

5. OQutfine — the best view for editing shdes

Change the colour background of
slide(s)Pg12-13

Change Slide Po!

ewTab
id

* Dragand Drop

Use Cut/ Copy/ Paste to move or copy to
another presentation

Switch

Windows ~

Macros

Good Practice Pg11

* Use differenttitlefor each slide to distinguish
in the outlineview



Delete/ Hide Slide
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Apply Desizn to your Present
12
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Change Shide Position P @
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Right click on the requested slide

Cut

Copy

Paste Oplions:
=) |l

Mew Slide

Duplicate 5lide

C Delete Slide >

Publish Slides
Check for Updates 4

Layout 4
Beset 5lide

Format Background...

Hide Slide



Master Slide

* View Tab

* Slide Master

* Insert Tab (picture/ shape/ clipart)
* View Tab again

* Close slide master view

Important: to apply/ DELETE/ modify from slide
master always click on the FIRST slide



Enter Text into Footer of specific
slides/all slides

° I nse rt Ta b FH&aZer and Footer ‘ - [
* Header and Footer e (e
) Update automatical [ appy |
| Cancel |

Apply — to the selected
slide cepmer

uuuuuu

Apply all —to all slides —

Date/ Time(left) , Slide
Number(right), Footer
(centre)




Edit text within/between Presentation

* Cut/ Copy =2 Paste

v'Select text

v’ Cut/Copy from ribbon or right click menu
v'Place the curser as requested/ desired

v Click on Paste



Font Type v - e Text alignment

Font Size ;.

Bold B

, I
Italics

Underline
Shadow
Font colour
Case changes

Formatting

e Numbered list
e Bulleted list =1
* Line spacing ,_.

 |ndentation

¥
I

i,-

ﬁaf

Always select text first
and than format
accordingly



Indent

Example:

Printer

Par
> Scanner Increase List Level
> Keyboa rd Increase the indent level,
» Mouse

Decrease Indent level



Tables

Two Methods

Method 1: Method 2:
Insert Tab _
Table

Important to have the slide layout
with content with caption

For both methods define the
number of rows and columns



Tables Design/ Layout

Julianne

= To insert text in a cell, click in the desired tab and star writing

v —
DESign Tab Design Layout MethOd 2

e Background colour | L2 snading - Right Click on the table

- | i Borders - -
- 3 Effects - for formatting tools
Layout Tab
* |nsert rows columns
* Delete rows/columns
e Insert Design Transitions Animations Slide Show Review View Design Layout
s E‘i‘:l ‘I\}EI GE_I E-j' Di:l 3] Height: 103 em = HT Distribute Rows === “I‘f’l‘ J 1l Height: | 206 cm <
- - S width: 2286 em 2
i _I W . - 1 T =3 =
Delete ir::.e»r; ér:;: [ﬁ:tﬂ Efﬂ EEH: a3 Width: |4.57 cm ¢ | Distribute Columns | ) |<| E[Dir;:t?:n'r‘..lafsilgsv Lock Aspect Ratio

Rows & Columns Merge Cell Size Alignment Table Size



Modify Table Width

1. Rest the pointer over the column or row boundary you want to change. The
.

i —— +||+
pointer changestoa +{or ” :

2. Drag the column or row boundary to a new location.



Charts

Two Methods

Method 1: Method 2:
Insert Tab

Y
Chart

Important to have the slide layout
with content with caption

Than choose the Chart Type



Chart Terms

Chart Area

Reductions

Chart Plot

\

7
_

Legend

Chart Tj

Data

series——

.

Gridlin

Clothing Shopping Entertainment Internet

Other

AXIs




Using datasheet to create charts

Pl @ = ECDLModule Presentation [Compatibility fcr = é]'ﬂg S R s Vcrosort PowePomt Microsort Excol W o o = s e
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Use the datasheet to replace with the existing
datasheet with the information you wish to enter/
to display in the chart



O R, N WP~ ULO

Change Chart type

Chart Title

111

Category Category Category Category
1 2 3 4

Cut

Copy
Paste Options:

2| [

&9 Reset to Match Style

G &=

[ S TR ST .
1 1 1 1

Eont...
i oy

nl‘] Change Chart Type...
— ) Change Save As
L@ Edit Data... hart Type Template
*.:j; Bring to Front | 4
'-.]_J; Send to Back | 4

Save as Picture...

Tateonn " ateonr ﬁ. Format Chart Area...

rie I

M Series 1
M Series 2

Series 3

Insert Design
EezzlaEE|
—lin] 3]
Select  Edit

Data Data

Transitions Animations

Two Methods

Method 1:
* Right click on the chart
* Change Chart type

Method 2:

* Click on the table
* Design Tab

* Change Chart type

Slide Show Review View | Design Layol

|
—_—

T T MY



60
50
40
30
20
10

Let’s Modify

Chart Title

Monday

M Girls

M Boys

Tuesday Wednesday Friday

Change the Chart title to Students’ Attendance

Change the Chart Background to a colour of your choice
Apply Data Labels to all bars of the chart

Change the girls Column Colour to a colour of your choice



Edit Table Labels

 Click on the Chart
e Design Tab
 Edit data



Organization Charts

* |nsert
* Smart Art

Insert Design Transitions Animations Slide Show

Review

WView

= - @ er A =h ':“ n <)
= = [re -
0 @+ P2l § = EER ;
lip Screenshot Photo Shapes SmartArt Chart H A Text Header WordArt Date Slide Object Equation Symbo Video Audio
art 7 Album ~ < Box & Footer 7 & Time Number E < =
Images Illustrations Links Text Symbals Media
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H List

8

80 Process

harts g 33

—
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Basic Block List

Use to show non-sequential or grouped
blocks of information. Maximizes both
herizontal and vertical display space for
shapes.

Usually, in the exams asks for a hierarchy - - -




Hierarchy Organization Chart

Julianne

Insert Text by clicking in a box and start typing B reme e
Delete a box by selecting it and press DELETE p——
Promote (up) /Denote (down) T | Adashapepetor
Use the Add Shape | oo
Add shape after/ before — to the same level

Add Assistant

L. Add Assistant



Graphical Objects

[nsert

(i

q Home
Clip Art . 58
. Ficture IiI.Iir:u Scree|
Picture At

Duplicate Picture (Copy > Paste)

Move Picture (Cut - Paste)
Resize Picture (resizing handles/ Format Tab)

I

i

Resizing handle

3 || Height: 453 em 2

1 Width: 493 em %



Rotation

Computer Lesson

Weekend

Flip the pink arrow with the text, Computer lesson, Horizontally —
Flip Horizontally.

Flip the orange arrow with the text weekend, vertically — Flip
Vertically.



Alignment

* Centre the middle circle horizontally. It should
be alighed to the slide — Distribute
Horizontally.

e Align the middle circle relative to the left of
the slide — Allgn Left
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: Home Insert Design Transitior
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Picture Clip Screenshot Photo Shapes
Art b Album ~ -

| Recently Used Shapes 1
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Lines
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4 Equation Shapes
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Flowchart
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5tars and Banners
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Callouts
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Action Buttons
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30 of 30 | “Office Theme™ [ <% Fralish (LLE3 |

Insert Shapes

Insert Tab
e Shapes

Select shape accordingly

Every shape has a label




Formatting Shapes

__,‘_,_,\_‘-_I__\_l.‘1FI o o \—
Format To Format always click on the shape
+| && Shape Fill - e Shape Fill = Inside Colour
] v £ Shape Outline - * Shape Outline — to modify the line
| it Sh Effects -~
ApE e width of the shape = |
ape effects - Shadows D “ [ ﬁ -
-ml!d!ng!""

The resizing handles are used to
modify the size of the shape




Insert Text in Shapes

* Right click on the shape
 Start typing

Edit Text
<. Edit Paints
'-I_:a Ering to Front | L4
By sendto Back | »
% Hyperlink...

Save as Picture..,

LE

5et as Default Shape
-§|J 5ize and Position...
%— Format Shape... —_—




Arrow Start/ Finish Styles

1cr OWET= ol Dra |l||..‘—

F

how Review View Format é

- [Zlshape outline -| /A ° Select the arrow

Theme Colors
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Shadow Dash type:
-— Reflection Cap type:
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I 3-D Rotation Begin type: End type:
' . Picture Correctidgs Begin size: E End size: E
Ficture Color \
o » Artistic Effects
= Crop
> Size
> & Position
—_— Text Box
+— More Arrows...
- - Alt Text




Group/Ungroup Objects

* Select all objects by using shift key
* Right click
* Group/ Ungroup

1A o T
#  Cut \l
53 Copy 4
[ Paste Options: .
2| |l
18] Group I8 Group
Iy '1_,]; Bring to Front | 4
IEI “']—Ei 5end to Back | 4

Save as Picture...

—fl",J 3ize and Position...

+..
B, Format Object..




Bring Forward/ Front, Backward
Back

These are accessed from the Format Tab

| |  Forward — One Layer
* Front—All Layer

 Backward — One Layer
* Back — All Layer

h,!] Bring Forward -
_,_'] 5end Backward -
"_'fl';g. 5election Pane



Animations

e Animations are accessed from the Animation
Tab

e To remove animations
* To modify speed



- Ani

Presentationl - Mi

Slow
Medium
e Fast

R R O R - S PR Y- T RN
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1911
07/10/2015



To Remove Animations

= L R Presentationl - Microsoft PowerPoint - = x
Home Thsert Design Animations Slide Show Rt et e Dewveloper (7]
PI' . il Transition Sound: [Mo Sound] = | Advance Slide
J ‘—@—‘ % % '—ﬁ—' Ié a g | i‘ﬂr Transition Speed:  Fast = | ¥ On Mouse Click
Preview |2 imati
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Click to add notes

|b Play | |E[ Slide: Show |

J| AutoPreview
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"ffice Theme" \",/

| BI85 T [ 64%

52)

Click on the
Animations Tab

e Custom Animations
e Select animations
* Remove



Click to add title

* Clickto add text

.uz
Click to add title

Click to add notes

.



Design Tab - Page Setup/
Orientation Pg 48

|m Haome Insert Design Transitions Animations Slide Sh
0 & ;
Aa Aa Aa ﬂ Aa .
Page Slide mmmmns _ ||| emew pLEs =
Setup Orientation * = =
Page Setup

Slides sized for:
COwverhead

A4 Paper (210x297 mm)

B4 (IS0) Paper (250353 mm)
B5 (ISQ) Paper (176x250 mm)
35mm Slides

-~

Qverhead

Banner
Custom

e

Y

1 =

Page Orientation: Landscape/

Portrait
Page Setup: Overhead (suitable

e R =

=]

QOrientation
Slides

Portrait
@ Landscape
Motes, handouts & outline

@ Portrait
Landscape

Cancel

for audiences)



Office Button - Print Options

Print (7 [
Printer
Name: % 1110.0.0.59\HP Officejet 6200 series |»| | Properties |
SR Idie . Find Printer... ’
Type: HP Officejet 6200 series —_——
Where: UsBoo1
Comment: Print to file

Print range Copies M O re t h a N
Al | \ @ All Current slide Number of copies:// 1 C O py

1 =
/ Slides: 1 1
Ra n ge Enter slide numbers and/or slide ranges. For example, !
Ucdlate |

1,3,5-12
Print what: Handouts —— After each
Handouts— i = , (IC2
Color farayscale: CRSLST S % Ot h e r
Color b 7 "

1,2,3,4—-1,2,3,4

Scale to fit paper

Frame slides High guality

_ Preview | OK | Cancel \




Start a Slide Show

* From Slide Show Tab
* From Beginning — From first slide

* From Current Slide — from the present slide

For instance, if asked to start the slide show
from slide 6, go to slide 6, select slide show tab
and than select from current slide.

L J 0 ememm

|m| Home In
- —-r -
_-'E:l-l %tr

From From
BEeginning Current Slide



